


2 

 

Stephen Moffat

Outlook 2007 
Part I

Download free eBooks at bookboon.com



3 

Outlook 2007: Part I
© 2014 Stephen Moffat & bookboon.com
ISBN 978-87-7681-891-3

Download free eBooks at bookboon.com

http://bookboon.com


Outlook 2007: Part I

4 

Contents

Contents

	 Foreword	 9

Section 1	 Outlook Essentials	 10
Foreword	 11
Getting Started	 11
Exploring the Outlook Window	 12
Navigating in Outlook	 14
Getting Help	 16
Obtaining Context-Sensitive Help	 18
Printing Documents	 19
Setting Up the Page	 22
Selecting Additional Printing Options	 24
Previewing and Printing a Document	 24
Ending an Outlook Session	 25
Minimizing and Restoring Outlook	 27
Exiting from Outlook and Logging Off	 27
Assignment	 28

Download free eBooks at bookboon.com
Click on the ad to read more

https://inspiredbusinessmedia.co.uk/conferences/cmo-inspired-oct-2018/


Outlook 2007: Part I

5 

Contents

Section 2	 Communicating with Mail	 29
Using the Inbox	 30
Checking for New Messages	 30
Previewing and Opening Messages	 32
The Ribbon	 34
Selecting and Printing a Message	 35
Closing a Message	 36
Sorting Messages	 36
Filtering Messages	 37
Composing a New Message	 38
Addressing and Typing a Message	 39
Editing Text	 41
Formatting Text	 43
Using AutoComplete	 46
Including an AutoSignature with a Message	 46
Correcting Spelling as You Type	 47
Sending a Message	 49
Forwarding and Replying to Messages	 51
Replying to a Message	 52
Managing Messages Using Folders	 54
Moving a Message to a Folder 	 57

Download free eBooks at bookboon.com
Click on the ad to read moreClick on the ad to read more

Free eBook on  
Learning & Development
By the Chief Learning Officer of McKinsey

Download Now

http://s.bookboon.com/Download_Free


Outlook 2007: Part I

6 

Contents

Deleting and Restoring a Message	 59
Assignment	 61

Section 3	 Organising Contacts	 63
Creating a Contact List	 63
Adding Contacts Manually	 65
Selecting and Editing an Address Card	 68
Transmitting and Adding Contacts with E-mail	 69
Managing Contacts	 71
Changing the Current View	 73
Assignment	 74

Section 4	 Scheduling with Calendar	 Part II
Navigating in Calendar	 Part II
Viewing a Day, a Week, or a Month	 Part II
Using the Date Navigator	 Part II
Viewing a Range of Dates, Several Weeks, and Discontiguous Days	 Part II
Showing Two Time Zones	 Part II
Making and Moving Appointments	 Part II
Selecting an Appointment and Modifying the Date in Day View	 Part II
Modifying the Date in Week View	 Part II
Changing the Time of an Appointment	 Part II

Download free eBooks at bookboon.com
Click on the ad to read moreClick on the ad to read moreClick on the ad to read more

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 
© Deloitte & Touche LLP and affiliated entities.

360°
thinking.

Discover the truth at www.deloitte.ca/careers 

http://www.deloitte.ca/careers


Outlook 2007: Part I

7 

Contents

Managing Appointments	 Part II
Editing Recurring Appointments	 Part II
Creating Tentative Appointments	 Part II
Inserting All Day Events	 Part II
Deleting Appointments	 Part II
Restoring Deleted Appointments	 Part II
Assignment	 Part II

Section 5	 Advanced Formatting	 Part II
Working with Tasks	 Part II
Creating a Task	 Part II
Selecting and Editing a Task	 Part II
Making a Task Recurring 	 Part II
Deleting and Restoring a Task	 Part II
Managing Tasks	 Part II
Setting the Priority for a Task	 Part II
Tracking a Task’s Status and Marking a Task Completed	 Part II
Using Task Timeline View	 Part II
Assignment 	 Part II

Download free eBooks at bookboon.com
Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

TMP PRODUCTION NY026057B

PSTANKIE

gl/rv/rv/baf

ACCCTR0005

Bookboon Ad Creative

4

6 x 4

12/13/2013

Bring your talent and passion to a
global organization at the forefront of
business, technology and innovation.
Discover how great you can be. 

Visit accenture.com/bookboon

©
2013 Accenture. 

All rights reserved.

http://s.bookboon.com/accentureCZintl


Outlook 2007: Part I

8 

Contents

Section 6	� Keeping a Journal and Utilising Notes	 Part II
Tracking Activities	 Part II
Recording Activities Automatically	 Part II
Setting Shortcut Opening Options and Using a Journal Entry as a Shortcut 	 Part II
Working with Notes	 Part II
Writing a Note	 Part II
Opening and Editing a Note	 Part II
Organising Notes	 Part II
Changing Icon Size	 Part II
Assignment 	 Part II

	 Appendix A	 Part II

	 Appendix B	 Part II

	 Appendix C	 Part II

Download free eBooks at bookboon.com
Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

 

 
                . 

http://s.bookboon.com/AlcatelLucent


Outlook 2007: Part I

9 

Foreword

Foreword
This course was written for trainees wishing to learn to use Microsoft Outlook. It is written for using Microsoft Outlook 
in the Office 2007 suite of applications. However, it does not include a ‘New Features’ section exclusively about new 
features in Microsoft Outlook within Office 2007. It is very easy to see a complete list of the new features in Office v2007 
in the Help menu on-screen. This courseware cannot and should not compete with the comprehensive coverage of new 
features detailed by Microsoft within the application’s help files. To do so would be to hinder learning the raw application.

What this course seeks to do is teach the trainee Outlook in the hope that he/she may be able to go and work just as well 
using v2002 for example and other versions. Wherever possible, ‘version functionality’ is purposely avoided. 
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Section 1	 Outlook Essentials
Objectives

At the completion of this lesson you will be able to: 

•	 Z
•	 Get Help
•	 Print Documents
•	 End an Outlook Session

Topics

Foreword
Getting Started
Exploring the Outlook Window
Navigating in Outlook
Getting Help
Choosing an Office Assistant
Obtaining Context-Sensitive Help
Printing Documents
Setting Up the Page
Selecting Additional Printing Options
Previewing and Printing a Document
Ending an Outlook Session
Minimizing and Restoring Outlook
Exiting from Outlook and Logging Off
Assignment
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Foreword

This is an introductory course and it is therefore assumed that the student or delegate is new to Outlook. It is for this 
reason that the new features are not listed exhaustively in the opening chapters of a course aimed at beginners. This is 
especially relevant with Office. There are many new feature in Outlook and many new features that are more general to 
the Office ‘super application’ or suites. 

For this reason, the new Outlook features are stored in two appendixes (A and B) at the end of this course, together with 
an overview of the new features in Word in Appendix C. Delegates who are taking this course as a refresher may like to 
turn to them now. Although most of the new features can be found in the appendixes it is not a complete catalogue and 
delegates wishing to delve deeper into the subject ought to sit an Outlook Upgrade course.

Getting Started

Microsoft Outlook is a software program that helps you manage your messages, your time, and your documents. Every 
day you have a variety of appointments and tasks, you send and receive messages, you open and close documents, you 
make notes, you call your colleagues and contacts, and you manage your files. Outlook integrates all these features into 
one program with one database. Outlook is most effective when used on a network, that is, when it is used with two or 
more computers that are physically connected.

With Outlook, you can record simple and complex appointments and resolve conflicting appointments. You can keep a 
list of tasks, somewhat like the to do list you might have on your desk, record information about business and personal 
contacts, review who you phoned and when, store notes and reminders to yourself, plan events for the entire year, and 
even track birthdays and anniversaries. 

Method

To start Outlook and log in:

1.	 Log in to the network.
2.	 On your desktop, double-click the Outlook icon.
3.	 If necessary, in the Profile or Mail dialog box, in the appropriate text box, type your user ID.
4.	 In the Password text box, type your password.
5)	 Choose OK.
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Exercise

In the following exercise, you will start Outlook and log in.

1.
Follow your instructor’s directions to start 
your computer and log in to the network

2. Double-click the Outlook icon
You may be prompted for network or E-Mail 
profile information.

3.
If necessary, in the Mailbox text box, 
type your user ID as provided by your 
instructor

4.
In the Password text box, type your 
password as provided by your instructor

5. Choose OK The Outlook window appears.

Exploring the Outlook Window

The Outlook window, as illustrated in Figure  1‑2, appears at start up. The window opens in its non-maximized view 
displaying the Inbox. The window contains a title bar, menu bar, and status bar common to other Microsoft application 
windows. The toolbar contains context sensitive tools. 

The Navigation pane (previously called the Outlook Bar) is a screen element that contains shortcuts to the folders, where 
you store your information. You use the shortcuts, which store the folder location, just as you would use shortcuts on your 
desktop. You click a shortcut to access the information in your Inbox, your Calendar, your contact list, your task list, your 
Journal, and your notes. For example, when you click the Inbox shortcut, a list of the messages you received appears in 
the reading pane, that area of the Outlook window that displays the data for whatever folder is active. Group buttons at 
the top and the bottom of the Outlook Bar give you access to additional shortcuts to your remaining mail folders and to 
your file management folders. The To Do Bar is a new addition for 2007 and shows a preview of your outlook calendar 
and lists your up and coming tasks.
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Figure 1-2: The Components of the Outlook Window

Table 1‑1 describes the components of the Outlook window.

Component Function

Navigation Pane
Holds folder shortcuts (icons) and buttons. Click a shortcut to activate an 
Outlook folder. Click a group button to access a different group of folders.

Folder List
Helps for easy navigation between folders. The display is more akin to the 
Windows Explorer.

Toolbar
Holds context-sensitive buttons that provide shortcuts for many menu 
and keyboard commands.

To Do Bar
Shows a preview of your outlook calendar also allows you to see up and 
coming appointments and tasks.

Find Function
Allows you to search your Inbox for a particular message using specific 
criteria, e.g. Date, name, subject

Shortcuts Icons on the Outlook Bar that provide access to Outlook folders.

Group buttons Buttons that reveal additional groups of Outlook shortcuts.

Reading Pane If switched on, shows a preview of the selected E-Mail message.

Table 1‑1: Outlook Window Components
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Navigating in Outlook

The Navigation Pane

Microsoft Outlook consists of the Navigation Pane, which is your time management tool; the Mail group, which lets you 
process your e-mail; and personal and archive folders which allow you to store and sort old emails. 

Each Outlook feature functions as a program on its own, yet, because Outlook integrates the data into one database, the 
features work together to let you pull data from one directly into another. 

The Navigation Pane gives you access to the Inbox, Calendar, Contacts, Tasks, Journal, Notes, and Deleted Items folders. 
The Mail group gives you access to the Inbox, Sent Items, Outbox, Deleted Items folders, Personal and Archive folders. The 
Inbox folder in the Outlook group is the same Inbox folder that is in the Mail group. You simply access it from different 
groups. The Deleted Items folder is also accessible from both folders.

You use the Outlook Bar shortcuts and the Folder Banner to navigate from folder to folder within Outlook. You can also 
use the Go menu to move from folder to folder.
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Table 1‑2 gives a brief description of each folder.

Shortcut Folder Function

Inbox
Holds and displays incoming e-mail. Available in Outlook and 
in Mail.

Calendar
Lets you create and manage appointments, schedule 
meetings, and respond to invitations. Also gives you access to 
your tasks. Available in Outlook.

Contacts Holds your phone and address list. Available in Outlook.

Tasks
Lets you list and prioritize what you need to do. Available in 
Outlook.

Journal
Tracks e-mail, phone calls, and files you open. Available in 
Outlook.

Notes
Lets you store and organize information you would normally 
jot down on paper or sticky notes. Available in Outlook.

Deleted Items
Stores deleted items so you can retrieve them, if necessary. 
Available in Outlook and in Mail.

Sent Items Holds copies of e-mail you have sent. Available in Mail.

Outbox
Holds e-mail you sent that your e-mail system has not yet 
forwarded to the recipient. Available in Mail.

Search Folder
Search Folders display the results of previously defined search 
queries. The messages shown remain stored in one or more 
Outlook folders.

Junk E-Mail

The Junk E-mail Filter is on by default, which is designed to 
catch the most obvious junk e-mail messages.

Draft

Outlook automatically saves all unfinished messages for you. 
By default, unfinished messages are saved to your Drafts 
folder.

Table 1‑2: The Outlook Bar Folders and Their Functions

The simplest way to navigate from folder to folder is by using the group buttons and the shortcuts on the Outlook Bar. 

Method

To navigate in Outlook:
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Navigation Pane method

1.	 On the Outlook Bar, click the desired group button.
2.	 Click the desired shortcut.

Exercise

In the following exercise, you will navigate in Outlook.

1. If necessary, maximize the window

2. At the bottom of the Navigation Pane, 
click the Mail group button

The Mail group button moves to the top of 
the Outlook Bar. The Mail shortcuts appear.

3. Click the Sent Items shortcut The words Sent Items and an envelope 
graphic appear on the Folder Banner. A list 
of your sent items appears.

4. Click the Notes folder The word Notes and a graphic of a 
sticky note appear on the Folder Banner. 
Large icons of your notes appear in the 
information viewer.

5. From the Go menu, choose Contacts The word Contacts and a rotary card 
file appear on the Folder Banner. The 
information viewer shows the beginning of 
your contact list in alphabetical order and 
displays alphanumeric tabs for access to 
additional contacts.

6. At the top of the Outlook Bar, click the 
Outlook group button

The Outlook Bar displays the Outlook 
shortcuts.

7. Click the Calendar shortcut The word Calendar. Your Calendar for 
today appears. You have no appointments 
for today. You do have three tasks.

Getting Help

As a new user, you need to know where you can get help. When you have a question about Outlook, you can access online 
help quickly and easily. You can display ToolTips, use Outlook Help, obtain a list of Help topics from Help Contents, 
or search for information about a specific topic using Help Index and Help Find. If you need help when you are using a 
dialog box, you can choose the Help button in the dialog box to see its related Help box.

In Outlook, the simplest Help aid is ToolTips. A ToolTip appears when you point the mouse pointer to a button on the 
toolbar. For example, if you point to the Print button, the ToolTip Print appears. If you click the Print button, you print 
the document.
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Using Outlook Help

Figure 1-3: Accessing Outlook Help

As shown in Figure 1-3, in the top right hand Corner of the screen you can type a question for help. Clicking on the 
Question Mark or using the help menu will open the help function giving you an overview of what is available in help. 

Method

To use Outlook Help:

1.	 Click the question mark icon to open the help function
2.	 When help opens you can click through the topics listed or use the search command.
3.	 2. Type your query into the “Type a question for help” box
4.	 2. Select an appropriate article from the displayed help topics.
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Exercise

In the following exercise, you will use Outlook Help.

1.
On the toolbar, click the Question Mark 
Icon

The Help screen will load. Giving you a 
choice of topics and a search bar

2. In the search box, type calendar

3. Choose Search The results of your search are displayed.

4.
Click the “Outlook Home” link at the top 
of your search results box

This returns you to the Help Screen

5.
Position the mouse pointer over the call 
out containing the words Email Messages

The pointer becomes a hand.

6. Click the call out 
A help screen that explains Email Messages 
appears.

7.
Click the “Outlook Home” link at the top 
of your search results box

This returns you to the Help Screen

8. Click another call out
The help screen explaining the item 
appears.

9.
Continue to examine the Help window, 
and, when you are finished, close the 
window

12.
Type “Email Accounts” into the “Type a 
question for help” box and press return

The help screen loads with suitable help 
topics relating to your query

13. Choose a suitable article Close the help window

Obtaining Context-Sensitive Help

You might sometimes need help when using a dialog box. During any step of a dialog box process, clicking the question 
mark to the left of the dialog box Close button and then clicking the area of the dialog box about which you have a 
question displays a ScreenTip, context-sensitive information about the area.

Method

To obtain context-sensitive help:

1.	 In any dialog box, click the question mark to the left of the Close button.
2.	 Click the area where you want help.
3.	 Read the information, and then click anywhere.
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In the following exercise, you will obtain context-sensitive help.

1. Make sure the Calendar is open

2. From the Tools menu, choose Options 
The Calendar page of the Options dialog 
box appears.

3.
Click the question mark to the left of the 
Close button

A question mark appears beside the mouse 
pointer.

4. Click the area where you want help. The help information appears.

5.
Read the information, and then click 
anywhere

The help information disappears.

6. Choose Cancel to close the dialog box

Printing Documents

You can print any Outlook files to carry with you when you are out of the office. If you usually carry a paper day planner, 
you can print the file in the size and layout of your planner. Using the Print dialog box, shown in Figure 1‑6, and the Page 
Setup dialog box, shown in Figure 1‑7, you can select from a variety of layouts and print any number of sequential days 
for your calendar. You can print your contact list in numerous styles and sizes, including a size for your rotary card file. 
You can print your e‑mail, your journal, and your tasks, as well. You can choose to preview your selection before printing 
to ensure that your layout, paper format, and date or alphabet range is correct.

Figure 1‑2: The Print Dialog Box
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Figure 1‑3: The Page Setup Option

Setting Up the Page

You might want to print today’s schedule to carry to a local appointment, or you might prefer to print a full week’s or 
month’s schedule to take with you on a business trip. You might also need to print your Task list or your Contacts list. 
Outlook lets you print your information in whatever layout you specify and lets you customize the page.

Method

To set up the page for printing:

1.	 Open the Folder from which you want to print.
2.	 From the File menu, choose Print.
3.	 In the Print dialog box, choose Page Setup.

4.	 In the Page Setup dialog box, on the Format page, select the options you want.
5.	 Select the Paper tab.
6.	 On the Paper page, in the Paper area, select the options you want.
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7.	 If desired, select the Header/Footer tab, and then type the desired header and/or footer.
8.	 Choose OK.

Exercise

In the following exercise, you will set up the page for printing.

1. Make sure the Calendar is open

2. From the File menu, choose Print The Print dialog box appears.

3. Choose Page Setup The Page Setup dialog box appears.

4.
On the Format page, in the Options area, 
from the Print from drop-down list, make 
sure 9:00 AM is selected

5.
If necessary, from the Print to drop-down 
list, select 9:00 PM 

6. Select the Paper tab The Paper page appears.

7.
If necessary, in the Paper area, in the Type 
list, select Custom (the last selection in 
the list)

8.
If necessary, in the Page area, in the Size 
list, select Day Timer Junior Pocket

The preview pane in the Orientation area 
shows four pages.

9. Choose OK The Print dialog box reappears.
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Selecting Additional Printing Options

You can select additional printing options in the Print dialog box. This is where you select the style and the range of your 
printout.

Method

To select additional printing options:

1.	 Open the Print dialog box.
2.	 In the Print Style area, from the list of previews, select a style.
3.	 In the Print Range area, from the drop-down lists, select the range.

Exercise

In the following exercise, you will select additional printing options.

1. Make sure the Print dialog box is open

2.
In the Print style area, from the Print style 
list, select Weekly Style

3.
In the Print Range area, make sure the 
Start drop-down list displays today’s date

4.
From the End drop-down list, select the 
date one week from yesterday

Previewing and Printing a Document

You should preview your documents before printing them to make sure you have set your options exactly the way you 
want them. When you are satisfied with the appearance, you can print your document.

Method

To preview a document:

1.	 In the Print dialog box, choose Preview.
2.	 If desired, in the Print Preview window, position the magnifier over the area you want to examine in detail, 

and then click the area.
3.	 If dissatisfied with the appearance of the document, on the toolbar, choose Page Setup to open the Page 

Setup dialog box and to reset options. Then choose OK to return to the Print Preview dialog box.

To print a document from Print Preview:

1.	 On the toolbar, choose the Print button.
2.	 In the Print dialog box, choose OK.
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To print a document from the Print dialog box:

1.	 Choose OK.

Exercise

In the following exercise, you will preview and print your Calendar.

1. In the Print dialog box, choose Preview
The Print Preview window appears 
displaying your Calendar for the current 
week.

2.
Position the magnifier over the date at 
the top left, and then click the area

The date area is magnified.

3. Click the area again
The Calendar zooms out to show the full 
week.

4. On the toolbar, choose Page Setup The Page Setup dialog box appears.

5.
If necessary, in the Options area, select 
the Arrange Top to bottom option button

The Preview area shows the days of the 
week arranged to print top to bottom, 
Monday through Wednesday in the left 
column and Thursday through Sunday in 
the right column.

6.
In the Options area, select the Arrange 
Left to right option button

The Preview area shows the days of the 
week arranged to print left to right, Monday 
through Sunday.

7. Choose OK The Print Preview window reappears.

8. Choose Print The Print dialog box appears.

9. Choose OK
The Calendar for this week and next is 
printed.

Ending an Outlook Session

As with any Windows application, when you are not actively using a program, you can choose to minimize it or exit from 
it. After checking your mail and your calendar at the beginning of the day, you might want to minimize Outlook. This lets 
you check for messages periodically without signing in and out of the program repeatedly. When a new message comes 
in you will get a desktop alert and an envelope icon (Figure 1-8) will appear in your System Tray It also lets Outlook send 
you reminders before your appointments. 

Figure 1-8

At the end of the work day, you should exit from Outlook and log off.
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Saving Your Data

In many applications, you must take some action to save your data as you work and when you finish your work session. 
In a database application such as Outlook, many actions you take are automatically saved.  

When you make entries in the information viewer, you activate the area of the pane in which you are working. As long as 
you are working in that area, you can freely make changes. When you write an appointment directly on your Calendar, 
write a note, write a task directly on your to do list, or enter an activity directly in your journal, Outlook saves your data 
as soon as you click anywhere outside the activated area.
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You can also enter appointments, contacts, tasks, and journal items using windows Outlook provides. These windows allow 
you to enter far more detailed information than you enter directly in the information viewer. The windows have a button 
on the toolbar that lets you save and close the window; only in these windows do you indicate whether to save. If you 
close such a window without saving, Outlook provides a message box that asks, “Do you want to save change?” to warn you 
that you are closing the window without saving your data and to give you another opportunity to save what you entered. 

When you receive a message, Outlook automatically saves it in your Inbox. After you read the message, you can have 
Outlook continue to save it in your Inbox or you can tell Outlook to save it in another folder. When you create an e‑mail 
message to send, you can save it in your Inbox to send later or you can send it immediately, having Outlook automatically 
save it in your Sent Items folder.

Minimizing and Restoring Outlook

By minimizing Outlook rather than exiting from it, you can quickly return to Outlook to check your messages, 
appointments, and notes. When you minimize Outlook, Outlook continues to run in the background. The application is 
represented on the taskbar by a button that displays the active Outlook folder, as shown in Figure 1‑9. When you have 
numerous programs running, the entire title is not usually visible. 

Figure 1‑9: Taskbar Showing Outlook Buttons

When you want to restore the Outlook window, you simply click the Outlook button on the taskbar.

Exiting from Outlook and Logging Off

Two exit options are available from the File menu—Exit and Exit and Log Off. When you use Exit, your Exchange-enabled 
applications continue to run. For example, if you receive an e-mail after you exit but you haven’t logged off, then Exchange 
notifies you that mail has arrived by displaying the envelope icon on the right end of the taskbar. You can reopen Outlook 
to open your mail.
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Choosing Exit and Log Off closes Outlook. If any Exchange-enabled applications are running, Outlook closes them also. 
Use this option at the end of the day.

Method

To exit from Outlook:

1.	 From the File menu, choose Exit.
or

2.	 Click the Close button.

To exit from Outlook and log off:

3.	 From the File menu, choose Exit and Log Off.

Exercise

In the following exercise, you will exit from Outlook and log off.

1. From the file menu, chose Exit and Log 
Off

Outlook is closed.

Assignment

1.	 Start Outlook and log in.
2.	 In the Mail Folders group, open the Deleted Items folder.
3.	 Switch to the Navigation Pane and read the notes in the Notes folder.
4.	 Ask the Outlook Help to give you information about making a recurring appointment.
5.	 From the Tools menu, choose Options. On the General page of the Options dialog box, in the General 

settings area, use context-sensitive help to learn what the Large toolbar icons option does.
6.	 Open the Contacts folder. Prepare to print your address cards in Card Style. If necessary, in the Page Setup 

dialog box, on the Paper page, select letter paper with the page sized for the Day Runner Classic paper 
planner. Preview and then print your cards.

7.	 Exit and log off from Outlook.
8.	 Restart Outlook and log in.
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Section 2	 Communicating with Mail
Objectives

At the completion of this lesson you will be able to: 

•	 Use the Inbox
•	 Understand the Ribbon
•	 Compose a New Message
•	 Forward and Reply to Messages
•	 Manage Messages Using Folders

Topics

Using the Inbox
Checking for New Messages
Previewing and Opening Messages
The Ribbon
Selecting and Printing a Message
Closing a Message
Sorting Messages
Filtering Messages
Composing a New Message
Addressing and Typing a Message
Editing Text
Formatting Text
Using AutoComplete
Including an AutoSignature with a Message
Correcting Spelling as You Type
Sending a Message
Forwarding and Replying to Messages
Replying to a Message
Managing Messages Using Folders
Moving a Message to a Folder
Deleting and Restoring a Message
Assignment
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Using the Inbox

When new mail arrives in your Inbox, Outlook notifies you. Whether you are working in Outlook or have Outlook 
minimized and are working in another program, Outlook makes a sound and displays an envelope icon on the taskbar 
when new mail arrives. Outlook also briefly changes your mouse pointer to the shape of an envelope to notify you of 
your new message. In Outlook 2007 you will also get a screen prompt in the lower right hand corner of the screen that 
will fade away after around 5 seconds (Fig 2-1).

Figure 2-1 : Mail prompt for new messages

The Inbox, the Outbox, the Sent Items folder, and the Deleted Items folder display the same context-sensitive Mail toolbar. 
Table 2‑3 summarizes the functions of these toolbar buttons.

Button Name Function

New Mail Message Opens the New Mail Message window so you can compose 
and send a message. The drop-down arrow gives you access 
to the New windows for the other Outlook features.

Forward Converts a message you received into a new message to 
which you can add comments. Then you can send the 
message to someone else.

Reply to All Converts a message you received into a new message to 
which you can add comments. Then you can send the 
message and your comments to the sender and to everyone 
else who received the original message.

Reply Converts a message you received into a new message to 
which you can add comments. Then you can send your 
comments to the sender.

Address Book Stores the e-mail addresses of all the names in your post 
office.

Table 2‑3: The Mail Toolbar Buttons

Checking for New Messages

Outlook checks your postoffice/Exchange server for new messages on a timed basis. The default checking time is every 
ten minutes. When you’re in Outlook, you can override this feature and check for new messages any time you want.
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Method

To check for new messages:

1.	 From the Tools menu, choose Send and Receive.

Exercise

In the following exercise, you will check for new messages.

1. From the Tools menu, choose Send and 
Receive

Any incoming messages are delivered to 
your Inbox.

Download free eBooks at bookboon.com
Click on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read moreClick on the ad to read more

http://s.bookboon.com/elearningforkids


Outlook 2007: Part I

32 

Communicating with Mail

Previewing and Opening Messages

Messages that others have sent you are stored in your Inbox. If you select the Inbox folder in the Outlook bar, a list of 
your messages appears in the information viewer. Each entry in the message list gives you information about the message, 
such as who sent it and its subject. This information is listed under the column headers, described in Table 2.2. 

Column 
header

Function

Indicates message importance.

Indicates message type.

Indicates whether there is an attachment.

Identifies the sender of the message.

Identifies the subject of the message.

Indicates when the message was received.

Indicates Category of message

Indicates the size of the file.

Flags the message for later action.

Table 2‑4:  Column Headers

Messages that you haven’t read appear in bold in the message list. You can preview messages by setting the message list to 
show you the first few lines of the message. When you open the full message, it appears in a message window, illustrated 
in Figure 2.2.
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Figure 2‑2:  The Message Window with a Received Message
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Method

To preview messages:

1.	 If necessary, on the Outlook Bar, click the Inbox shortcut.
2.	 From the View menu, choose AutoPreview.

To open a message:

1.	 If necessary, on the Outlook Bar, click the Inbox shortcut.
2.	 In the message list, double-click the message.

Exercise

In the following exercise, you will preview messages and you will open a message.

1. From the View menu, choose AutoPreview All messages display their first three lines.

2. In the message list, double-click the 
Outlook message

The Message window opens.

3. Read the message

The Ribbon

The Ribbon is the strip of buttons and icons located above the Message area in Outlook 2007. 

The Ribbon replaces the menus and toolbars found in earlier versions of Outlook. 

Above the Ribbon are a number of tabs, such as Home, Insert, and Page Layout. Clicking on a tab displays the options 
located in this section of the ribbon.

For example, when you click to read a message or create a new message in Outlook 2007 the mail ribbon is displayed, the 
options under the Message tab are displayed by default(see image below Figure 2-3). These options are grouped according 
to their function - such as Message (includes reply and forwarding options), and Actions (includes delete, move to folder, 
create rule and other actions options). 

Figure 2-3: Message Ribbon

Clicking on an option on the ribbon may lead to further options contained in a Contextual Menu that relate specifically 
to the option chosen.
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Selecting and Printing a Message

You can print the message that is currently displayed. You can also print a message without opening it.

Method

To select a message:

1.	 In the message list, click the message.

To print a message:

1.	 Open the message.
or

1.	 In the message list, select the message.
2.	 On the toolbar, click the Print button.
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Exercise

In the following exercise, you will print a message.

1. Make sure the Outlook message is open

2. On the toolbar, click the Print button The message is printed.

Closing a Message

When you have finished reading a message, you should close it. The message still appears in your message list, but the 
text that appears is no longer bold.

Method

To close a message:

1.	 In the Message window, click the Close button.

Exercise

In the following exercise, you will close a message.

1. In the Outlook message window, click 
the Close button

The message is closed. The text that appears 
is no longer bold in the message list. 

Sorting Messages

You can sort your messages by any item shown in the column headers of the message list. To sort your messages, simply 
click the column header on which you want to sort. By default, the first time you click the column header the sort occurs 
in ascending order. The next time you click the column header it sorts in descending order.

Method

To sort messages:

1.	 In the message list, click the desired column header.
2.	 If desired, click the column header again to change the sort order.
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Exercise

In the following exercise, you will sort messages.

1. Click the Sent Items shortcut in the folder 
list

The contents of the Sent Items folder appear 
in the information viewer.

2. In the column headers, click the To header The messages are sorted in alphabetical 
order based on the recipient name.

3. Click the Sent column header The messages are sorted by date and time 
order.

4. Click the Sent column header again The messages are sorted by date order 
opposite to the preceding step.

Filtering Messages

You can filter your data in each Outlook folder by selecting a filter from the Current View drop-down list. When you 
filter messages, you display a specified subset of messages. 

The Inbox Current View drop-down list gives you numerous criteria to use to filter the messages. Table   summarizes the 
Inbox Current View filters.

Name Function

Messages Shows the subject line of all messages in the folder.

Messages with AutoPreview Shows the subject line and the first three lines of all unread 
messages in the folder. Shows the subject line only of other 
messages.

Last Seven Days Shows only those messages received in the last seven days.

Unread Messages Shows unread messages only.

Sent To Shows who else received the same message.

Message Timeline Graphically shows when each message was received.

Table 2‑5: The Inbox Current View Filters

Method

To filter messages:

1.	 On the toolbar, click Arrange by. 
2.	 From the drop-down list, select Current view.
3.	 Choose OK.
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Exercise

In the following exercise, you will filter messages.

1. Make sure you are in the Sent Items folder

2. On the toolbar, click Arrange by option. The drop-down list appears.

3. From the drop-down list, select By 
Conversation Topic

The messages are grouped by subject.

4. Click the Current View drop-down list 
arrow from the Arrange by option.

The drop-down list appears.

5. From the drop-down list, select By 
Message Flag

The messages are all grouped as normal; no 
messages are flagged.

6. Filter the messages by Sent To

Composing a New Message

To compose a new message, you use the New Message window, shown in Figure 2-4. You can open the New Message 
window from any Mail folder by clicking the New Mail Message button on the toolbar. 

Figure 2‑4:  The New Message Window with a New Message to Send

To create and send a message, you must do three things. First, you must address the message. Second, you must type the 
body of the message, and third, you must send the message.
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The ribbon on the New Message window differs from the ribbon in the message window as it has more tabs available, 
Shown in Figure 2-5, facilitate creating, formatting, checking, addressing and sending the message..

Figure 2-5 : Compose Message Ribbon

Addressing and Typing a Message

To address a message, type the recipient’s email address e.g. joe.bloggs@somewhere.com or the recipients user name in the 
‘To’ text box. A user name is a unique name assigned to each Outlook user on your network. You can address a message 
to more than one recipient by separating each user name with a comma or a semicolon. If you’d like to send a courtesy 
copy of your message, type the recipient’s name in the’ cc’ text box.

You can also type the first few characters of the recipient’s user name and then, if Outlook can match the characters you 
typed with a user name, Outlook fills in the remainder of the name for you automatically. When an underline appears 
beneath a name in the ‘To’ text box, this indicates that Outlook has verified the name in the postoffice/server.

You should always type a short subject in the Subject text box. Your subject becomes the text in the line that the recipient 
sees in his or her message list when not using AutoPreview or the first line when using AutoPreview. 
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You can move from field to field by pressing Tab or by positioning the mouse pointer in the desired field and clicking the 
mouse button. After you’ve finished addressing the message, you can move to the message area and type your message.

Method

To address and type a message:

1.	 Check names method
2.	 In any Mail folder, on the toolbar, click the New Mail Message button.
3.	 In the New Message window, in the To text box, type the recipient’s user name.
4.	 If sending the message to multiple recipients, type , (comma) or type ; (semicolon), and then enter the next 

name.
5.	 Repeat step 3 as necessary.
6.	 If desired, in the Cc text box, type a user name(s).
7.	 In the Subject text box, type a short subject.
8.	 In the message area, type the text of your message.

NOTE: WHEN YOU TYPE THE FIRST FEW CHARACTERS OF THE RECIPIENT’S USER NAME, OUTLOOK 
CAN SOMETIMES IDENTIFY A MATCH FOR THE CHARACTERS ENTERED, AND YOU NEED NOT TYPE 
THE FULL NAME.

Dialog box method

1.	 In any Mail folder, on the toolbar, click the New Mail Message button.
2.	 In the New Message window, choose To.
3.	 In the Select Names dialog box, select a name from the list.
4.	 Choose To.
5.	 Repeat steps 3 and 4 as necessary.
6.	 Choose OK.
7.	 If desired, choose Cc.
8.	 In the Select Names dialog box, select a name from the list.
9.	 Choose To.
10.	Repeat steps 8 and 9 as necessary.
11.	 Choose OK.
12.	 In the Subject text box, type a short subject.
13.	 In the message area, type the text of your message.

Exercise

In the following exercise, you will address a message. Then, you will type your message.
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1. On the toolbar, click the New Mail 
Message button

The New Message window appears.

2. If necessary, maximize the New Message 
window

3. In the To text box, type your partner’s 
user name

4. Choose Cc The Select Names dialog box appears.

5. Select your instructor’s name

6. Choose Cc

7. Choose OK The New Message window reappears.

8. In the Subject text box, type Mail 
Activated

9. In the message area, type the following 
text, including the grammatical error: 
My Microsoft Outlook post office 
has been activated. I look forward to 
communication with you electronically.

Editing Text

After you type a message, you might need to make some changes before you mail the message. There might be misspelled 
words or grammatical errors. You might decide to add or delete text. In Outlook, you can edit—insert, delete, and replace 
text—in any message you are composing.

The procedure for inserting and deleting text in Outlook is the same as in most Windows word-processing applications. 
You add text by placing the insertion point where you want to insert the text and typing the text. You move the insertion 
point by positioning the I‑beam and clicking the mouse or by using the arrow keys. There are two ways to delete text. You 
can position the insertion point in the correct location and press Delete or Backspace, or you can select the text with the 
I-beam (drag the mouse to highlight the desired text) and press Delete.

Selecting text and then typing the replacement text lets you replace many characters quickly. You can easily replace a 
single word or a block of text ranging from a few words to several paragraphs.

Method

To insert text:

1.	 Position the insertion point where you want to insert the text.
2.	 Type the text.
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To delete text:

1.	 Position the insertion point behind the first character you want to delete.
2.	 Press BACKSPACE

or

1.	 Position the insertion point in front of the first character you want to delete.
2.	 Press DELETE

or

1.	 Position the I-beam in front of the first character you want to delete.
2.	 Drag the I-beam over the text to be deleted.
3.	 Press BACKSPACE or DELETE

To replace a block of text:

1.	 Position the I-beam in front of the first character you want to replace.
2.	 Drag the I-beam over the text to be replaced.
3.	 Type the replacement text.
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To replace a word:

1.	 Double-click the word.
2.	 Type the replacement text.

Exercise

In the following exercise, you will edit text.

1. In the message you just typed, in the 
first sentence, place the insertion point 
between the word activated and the 
period

2. Press Spacebar and then type today The text is inserted, and existing text is 
pushed forward.

3. Place the insertion point after the word 
communication in the second sentence

4. Press Backspace twice Two letters are deleted.

5. Without moving the insertion point, type 
ng

Two letters are inserted.

6. In the first sentence, position the I-beam 
in front of the h in the word has 

7. Drag to select the words has been

8. Type is The text is replaced.

9. In the second sentence, double-click the 
word electronically

The word is selected.

10. Type via e-mail The word is replaced.

Formatting Text

The Ribbon contains two areas for editing text in the Message Tab in the Basic Text group Figure 2-6 where you can bold, 
italicize, and underline text. You can also change the color of the text, add bullets, and change the alignment. In addition, 
you can change your font with the Font and Font Size drop-down lists. In the Format Text tab Figure 2-7 where more 
advance commands such as styles exist. 

Figure 2-6 : Basic Text editing tools
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Figure 2-7 : Format text Ribbon

Table 2-6  describes the buttons on the Basic Text grouping. 

Button Name Function

Bold, Italic, Underline Bolds the selected text. Italicizes the selected text. 
Underlines the selected text.

Highlight Text, 
Change font colour

Highlights text as would a highlighter pen. Changes the 
font colour

Align Left, Centre, 
Align Right

Left-aligns selected text 
in the message. Centre-aligns selected text  
in the message. Right-aligns selected text  
in the message.

Increase indent, 
Decrease indent

Increases and Decreases the indentation of the text.

Font Type, Font Size Changes the font type e.g. Arial, times etc. Changes the 
font size

Grow Font, Shrink 
Font

Increases and decreases font size

Bullets, Numbering Changes the selected text to bulleted text so that 
it starts with a bullet. Changes the selected text to 
numbered text so that it starts with a number.

Clear Formatting Clears all formatting on selected text.

Table 2‑6: Basic text  formatting tools

NOTE: MANY OTHER MAIL PROGRAMS CAN PROCESS ONLY ASCII, OR PLAIN TEXT, MESSAGES. USERS 
OF THESE PROGRAMS WILL NOT SEE YOUR FORMATTING.

Method

To format text:

1.	 Select the text you want to format.
2.	 Select the message ribbon, on the Basic Text Group, click the desired button.
3.	 If desired, from the Font drop-down list, select a font.
4.	 If desired, from the Font Size drop-down list, select a font size.
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Exercise

In the following exercise, you will format text.

1. In the first sentence, select the word 
Outlook 

The word is highlighted.

2. On the toolbar, click the Italic button The word is italicized.

3. In the second sentence, select the words 
via e-mail 

The words are highlighted.

4. On the toolbar, click the drop-down arrow 
to the right of the Font Colour button

The colour palette is displayed.

5. Choose Blue The words are coloured blue.

6. Select the word today The word is highlighted.

7. From the Font drop-down list, select any 
font

The font for the word is changed.

8. From the Font size drop-down list, select 
12

The font size for the word is changed to 
12 points.

9. On the toolbar, click the Centre button The message is centred.

10. On the toolbar, click the Align Right 
button 

The message is right-aligned.

11. On the toolbar, click the Align Left button The message is left-aligned.
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Using AutoComplete

AutoComplete automatically types such words as dates, salutations, and closures that are commonly found in messages. For 
example, if you start to type the word Monday, AutoComplete shows the word Monday as a tip in a box above your text 
once you type the letters Mond.  If you indeed want to type the word Monday, you press Enter to accept the AutoComplete 
text and then type your next word. If you don’t want to type Monday, you should just continue typing.

Method

To use AutoComplete:

1.	 Begin to type a word.
2.	 When the AutoComplete tip appears, press ENTER

Exercise

In the following exercise, you will use AutoComplete.

1. Position the insertion point at the end of 
your message, and then press Enter twice

2. Type your AutoComplete causes the tip Yours truly, to 
appear in a box above your text.

3. Press Enter AutoComplete types the rest of your phrase.

Including an AutoSignature with a Message

You can automatically include your name, a standard message, or any other text at the end of every message you send. 
You can choose a handwriting or calligraphy font for your AutoSignature to make it look as if you scanned it in. If you 
prepare a message on which you don’t want to include your AutoSignature, you can delete it. 

Method

To include an AutoSignature with a message:

1.	 In a new message, type and format your name as you want it to appear in your AutoSignature.
2.	 Click the Signature Button in the Include grouping on the Message tab and click signatures
3.	 In the AutoSignature message box, type a name for your new signature.
4.	 Click Add.
5.	 Choose whether to make it the default signature and whether to include it in replies.
6.	 Click OK.
7.	 Click OK.
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Exercise

In the following exercise, you will include an AutoSignature with your message.

1. Position the insertion point at the end 
of your message, and then press Enter

2. Type your first name

3. Format your name in the font of your 
choice

4. If necessary, select your name

5. Click the Signature Button in the 
Include grouping on the Message tab 
and click signatures

Make sure you are on the Message tab

6. Click signatures The AutoSignature dialog box is displayed.

7. In the AutoSignature dialog box type a 
name for the signature.

8. Choose whether to make it the default 
signature

9. Choose OK The AutoSignature dialog box closes.

10. Choose OK The Options dialog box closes

11. Click anywhere in the message The AutoSignature is deselected.

Correcting Spelling as You Type

As you type your message, your spelling errors appear underlined with a wavy red line. You can correct them as you type 
or wait until you send your message to correct them. 

Method

To correct spelling as you type:

1.	 When a wavy red line appears below a word, examine the word and, if necessary, retype it correctly.
or

1.	 When a wavy red line appears below a word, right-click the word.
2.	 From the shortcut menu, choose the correct word.
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Exercise

In the following exercise, you will check spelling as you type.

1. Position the insertion point at the end of 
the first paragraph, press Enter twice, and 
then type the following text, including 
the errors:

The followingis a preposed itinerary. 
If you have any concirns, please let me 
know!

A wavy red line appears below followingis, 
below preposed, and below concirns.

2. Place the insertion point after the g in 
followingis and press Spacebar

The spelling is corrected, and the wavy red 
line disappears.

3. Right-click the word preposed A shortcut menu appears with two 
suggested replacement words.

4. Choose proposed The spelling is corrected and the wavy red 
line disappears. One spelling error remains.
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Sending a Message

When you have finished typing the message, click the Send button on the toolbar. When you click the Send button, 
Outlook places your message in the Outbox. At regular intervals, the network checks your Outbox and sends the messages 
it contains. You can then find your message in the Sent Items folder.

You can set an option from the Tools menu to run a final spelling check when you send your message. If you set this 
option, then, when you send your message, if you still have a misspelled word, the Spelling dialog box, shown in Figure 2‑8, 
appears, and it shows you your errors. 

Figure 2‑8: The Spelling Dialog Box

Method

To send a message:

1.	 In the New Message window, on the toolbar, click the Send button.
2.	 If necessary, in the Spelling dialog box, in the Not in dictionary area, examine the word that appears in the 

red font.
3.	 If the word is spelled correctly, choose Ignore or Ignore All to accept the word for this message only or 

choose Add to add the word to your custom dictionary.
or
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4.	 If the word is spelled incorrectly, in the Suggestions area, select the correctly spelled word, if available, or 
correct the spelling in the Not in dictionary area.

5.	 Choose Change or Change All to correct the spelling for this message.
6)	 Repeat steps 2 through 4 as necessary.

Exercise

In the following exercise, you will send a message.

1. Make sure the message is still open

2. On the toolbar, click the Send button The Spelling dialog box appears. The Not in 
dictionary area displays the word concirns 
in red. The Suggestions area suggests the 
word with the correct spelling.

3. Choose Change The spelling error is corrected.

4. If your name appears, choose Add Your name is added to the Custom 
Dictionary. 

5. If necessary, correct spelling errors you 
made while entering the message text

The message is sent.
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Forwarding and Replying to Messages

Outlook lets you forward and reply to messages that you receive. If you want to forward a message to someone who 
did not receive the original, use the Forward button on the toolbar. The Reply to Sender button lets you respond to the 
originator of the message, while the Reply to All buttons lets you respond to all the individuals who received the message. 

Forwarding a Message

When you open a message and then click the Forward button, a New Message window opens containing the message 
you want to forward, as shown in Figure 2‑9. The title bar shows an envelope icon followed by the letters FW: and then 
displays the subject of the original message. After you address the message, you can add a comment at the top of the 
message area and then send it.

Figure 2‑9: The New Message Window When You Forward a Message

Method

To forward a message:

1.	 Open the original message.
or

2.	 In the message list, select the message.
3.	 On the toolbar, click the Forward button.
4.	 Address the message.
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5.	 If desired, at the top of the message area, type comments.
6.	 Send the message.

Exercise

In the following exercise, you will forward a message.

1. Click the Inbox shortcut in the folder list

2. If necessary, check for new messages

3. In the message list, double-click the 
message your mail partner just sent you

The message opens.

4. On the toolbar, click the Forward button The message appears in the New Message 
window.

5. Follow your instructor’s directions to 
address the message to another member 
of your class

6. At the top of the message area, type 
Look! [Your partner’s name] has 
Outlook!

7. Send the message

8. If necessary, close the original message

Replying to a Message

When you reply to a message, you can reply to the originator only or you can reply to the originator and to everyone 
else who received the message. Click the Reply to Sender button to respond to the originator, or click the Reply to All 
buttons to respond to the originator and to everyone else who received the message. Figure 2‑10 shows the New Message 
window when you reply to a message.

When you click a Reply button, a New Message window opens, just as it does when you are forwarding a message. In this 
case, however, the To text box is filled in for you with the original sender’s address or the sender and all the recipients’ 
addresses, and the insertion point is automatically positioned at the top of the message area.
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Figure 2‑10: The New Message Window When You Reply to a Message
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Method

To reply to a message:

1.	 Open the original message.
or

1.	 In the message list, select the message.
2.	 On the toolbar, click the Reply button.

or

3.	 On the toolbar, click the Reply to All buttons.
4.	 At the top of the message area, type your response.
5.	 Send the reply.

Exercise

In the following exercise, you will reply to a message.

1. In the message list, open the message 
from your mail partner

2. On the toolbar, click the Reply button The message appears in the New Message 
window with the original sender’s name 
filled in and the insertion point positioned 
at the top of the original message area.

3. Type the message.

4. Send the reply

5. If necessary, close the original message

Managing Messages Using Folders

When your messages”  arrive, Outlook stores them in the Inbox. As messages accumulate, your Inbox can become a 
confusing jumble. To help you sort things out, you can create folders for orderly message storage.

After you’ve read a message, you can move it to a folder for storage or, if you don’t need it anymore, you can delete it. 
Deleting messages saves you space on your hard drive.

You can manage your messages, and you can also manage data in other Outlook folders. The folder list displays a folder 
tree that looks like a folder tree you might see in Explorer and in My Computer. The Outlook folder list displays only 
the Outlook folders, as shown in Figure 2‑11. When the folder list is collapsed, you see only the main folders. When the 
folder list is expanded, you see the subfolders, too. In the folder list, you can create new folders, move data from folder 
to folder, and delete and recover data. 
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Figure 2‑11: A Collapsed Folder List

Creating a Folder

As you collect more and more data, you might want to make additional folders in which to keep your records more neatly. 
For example, you might want to store messages related to one project in one folder and messages related to another project 
in another folder. And once you get on e-mail mailing lists, you can certainly use additional file folders in which to sort 
the mail you received and want to keep. To keep organized, you can create a new folder in the Create New Folder dialog 
box, shown in Figure 2‑12.
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Figure 2‑12: The Create New Folder Dialog Box

Method

To create a folder:

1.	 Select the folder to which you want to add a subfolder.
2.	 From the File menu, choose New, and from the New submenu, choose Folder.
3.	 In the Create New Folder dialog box, in the Name text box, type the name for the new subfolder.
4.	 Choose OK.
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Exercise

In the following exercise, you will create new folders for your Inbox.

1. On the toolbar, click the Folder List 
button

The folder list appears.

2. Select the Inbox The message list appears.

3. From the File menu, choose New The New submenu appears.

4. Choose Folder The Create New Folder dialog box appears.

5. In the Name text box, type Mail

6. Choose OK The new folder appears in the folder list as 
a subfolder of the Inbox folder. The Inbox is 
selected.

7. From the File menu, choose New The New submenu appears.

8. Choose Folder The Create New Folder dialog box appears.

9. In the Name text box, type Class

10. Choose OK The second new subfolder appears in the 
folder list.

Moving a Message to a Folder 

Creating a folder hierarchy is helpful only if you use it to organize your messages. You should move a message from the 
Inbox to a long-term folder as soon as you read it and decide to keep it.

After you create new subfolders, you can move the messages you have stored in the Inbox folder to the subfolders you 
created. You can also move messages from one subfolder to another. 

When you display the folder list, you can drag a message from one folder to another. You can also use the Move to Folder 
button on the toolbar to move files from one folder to another. 

The Move to Folder button  displays a menu listing folders to which you have moved messages and also lets you 
access the Move Items dialog box. The Move Items dialog box, shown in Figure 2‑13, lets you select any folder into which 
to move the selected file. 
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Figure 2‑13: The Move to Folder Box

Method

To move a message to a folder:

Drag method

1.	 Display the folder list and expand it as necessary.
2.	 Drag the message to the appropriate folder.

Toolbar method

1.	 Select the message you want to move.
2.	 On the toolbar, click the Move to Folder button.
3.	 From the menu, choose the appropriate folder.

or

4.	 From the menu, choose Move to Folder.
5.	 In the Move Items dialog box, expand the folder list as necessary, and then select the appropriate folder.
6.	 Choose OK.
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Exercise

In the following exercise, you will move messages to a folder.

1. From the message list, drag the message 
from your partner to the Class folder

The message is moved and disappears from 
the Inbox message list.

2. Select the Outlook message

3. On the toolbar, click the Move to Folder 
button

A menu appears.

4. Choose Move to Folder The Move Items dialog box appears.

5. Make sure the Class folder is selected, 
and then choose OK

The message is moved and disappears from 
the Inbox message list.

6. In the folder list, select the Class folder Your partner’s message and the Outlook 
message appear in the message list.

Deleting and Restoring a Message

A cluttered Inbox makes it difficult to locate specific messages. You should delete messages you don’t want to keep. You 
might want to review the messages in all folders periodically and delete messages that are no longer relevant. If you have 
a message you no longer want, you can delete it using the Delete button on the toolbar .
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Deleted items go to the Deleted Items folder. If you want to recover an item from the Deleted Items folder, you can easily 
select and restore it. But once you delete items from the Deleted Items folder, Outlook removes them completely from 
your computer. They do not go to the Recycle Bin and are no longer retrievable. 

If you receive a notice that your hard drive or your network drive is running out of space, you should check your Deleted 
Items folder for items that you can permanently delete.

Method

To delete an item and hold it:

1.	 Select the item you want to delete.
2.	 On the toolbar, click the Delete button.

To restore deleted items:

1.	 Open the Deleted Items folder.
2.	 Select the item(s) you want to restore.
3.	 On the toolbar, click the Move to Folder button.
4.	 From the menu, if the folder is listed, choose the folder. 

or
5.	 From the menu, if the folder is not listed, choose Move to Folder.
6.	 If necessary, in the Move Items dialog box, in the Move the selected items to the folder: list, select the folder 

and then choose OK.

To permanently delete items:

1.	 Open the Deleted Items folder.
2.	 Select the item(s) you want to delete permanently.
3.	 On the toolbar, click the Delete button.
4.	 In the Office Assistant balloon or the message box, choose Yes.
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Exercise

In the following exercise, you will delete and restore items.

1. Make sure the Class folder is open

2. Select the Outlook message

3. On the toolbar, click the Delete button The message is deleted.

4. Open the Deleted Items folder The message appears in the list.

5. Select the Outlook message

6. On the toolbar, click the Move to Folder 
button

The menu appears.

7. Choose Class The message is moved to the Class folder 
and disappears from the Deleted Items list.

8. Open the Class folder The message is restored.

9. Open the Sent Items folder The message list appears.

10. Delete the message to Linda Elengold

11. Open the Deleted Items folder The deleted message appears in the list.

12. Select the message

13. On the toolbar, click the Delete button A message box that asks Are you sure that 
you want to permanently delete the 
selected item(s)? appears.

14. Choose Yes The message is permanently deleted.

15. On the toolbar, click the Folder List 
button

The folder list closes.

Assignment

1.	 Address a new message to your class partner with the subject Food Drive.
2.	 In the message area, type the following text (include the misspellings). Use the AutoComplete tip.

Dear Sir or Madam:

Next week we’re holding our anual food drive for the Orleans Parish Food Bank. We need non-perishible 
food items. Please bring your foodto my restaurant.

3.	 In the second sentence, insert the words canned food and other before the word non-perishable.
4.	 In the third sentence (Please bring…), add a space between donations and to. Then replace the word food 

with donations. 
5.	 Change the formatting of the Orleans Parish Food Bank to 14 point italic. Align the message to the right. 

Then realign the message to the left.
6.	 Delete your AutoSignature, and then create a new AutoSignature using your full name.
7.	 Correct the spelling and send the message.
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8.	 Check for a new message from your mail partner. Preview and then read the message. Print the message. 
Move the message to the Restaurant mail folder.

9.	 Open the Kerry Owen Farewell message.
10.	 Forward the message to your class partner, typing the following comment at the top of the message area: 

Would you like to bring something?
11.	 In the Inbox, move the Kerry Owen message to the Restaurant mail folder.
12.	 Open the Vendor Meeting message.
13.	 Reply to the sender with the following comment added at the top of the message area: I would like to 

attend. 
14.	 In the Sent Items folder, create a Business Mail subfolder and a Personal Mail subfolder.
15.	File the Joan Berry and the Anna Marble sent items in the Business Mail subfolder. File the Susan Crawford 

sent item in the Personal Mail subfolder.
16.	 Delete the Susan Crawford Sent Item from the Sent Items Personal Mail subfolder and then restore it to the 

same folder.
17.	Permanently delete the Vendor Meeting message.
18.	 Close the folder list.
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Section 3	 Organising Contacts
Objectives

At the completion of this lesson you will be able to: 

•	 Create a Contact List
•	 Manage Contacts

Topics

Creating a Contact List
Adding Contacts Manually
Selecting and Editing an Address Card
Transmitting and Adding Contacts with E-mail
Managing Contacts
Changing the Current View
Assignment

Creating a Contact List

When you open the Contacts folder, Outlook displays the contact list, illustrated in Figure 3‑1, in the information viewer. 
The contact list contains names, phone numbers, and other important information about your business and personal 
associates. With a contact list, you can store, update, organise, and retrieve your colleagues’ contact information. If you 
forget a contact’s name, you can look that person up another way, such as by workplace or by any other field listed in the 
contact information. 
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Figure 3‑4: The Contact List Screen
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If you have more contacts stored in your folder than you can display at one time in the information viewer, you can click 
one of the alphanumeric tabs at the right of the screen to display the contact you want.

As in other Outlook folders, there are context-sensitive buttons on the toolbar that are available only in the Contacts 
folder. Table 3‑7 describes the functions of these toolbar buttons.

Button Name Function

New Contact Opens the New Contact window so that you can add a new 
contact address card. The drop-down arrow gives you access 
to the New windows for the other Outlook features.

Print Prints your contacts list

Move To Folder Moves your contacts to another folder

Delete Deletes a contact

New Message to 
Contact

Opens a New Message window addressed to the selected 
contact.

Dial If connected, places a call to your contact. The drop-down 
arrow displays the selected contact’s phone numbers and 
gives you dialling options.

Categorize Organises your contacts into colour coded categories

Follow Up Allows you to flag a contact for follow up

Table 3‑7: The Contacts Toolbar Buttons

Adding Contacts Manually

At the very least, your contact list should include names and phone numbers, but the more inclusive you make your list, 
the more helpful it can be to you. To add contacts, type your data into the New Contact window, illustrated in Figure 3‑2, 
selecting fields as appropriate to enter additional details.
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Figure 3‑5: The New Contact Window

When you enter all the information in the New Contact window and save it, Outlook stores each contact in the contact 
list as an address card. Address cards in the contact list simulate business cards in your rotary or card file.

The Contact window has a ribbon of its own with four tabs containing the various commands Figure 3‑3.

Figure 3‑3: The Contact Window Ribbon

Method

To add contacts manually:

1.	 Open the Contacts folder.
2.	 On the toolbar, click the New Contact button.
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3.	 In the New Contact window, for all pages, fill in the text boxes, select the check boxes, and so forth, as 
appropriate.

4.	 On the toolbar, click the Save and Close button. 
or

5.	 On the toolbar, click the Save and New button to add another contact.

Exercise

In the following exercise, you will add contacts to your contact list manually.

1. Using the shortcut bar open the Contacts 
folder

The contact list appears in Address Cards 
view.

 2. On the toolbar, click the New Contact 
button

The New Contact window appears.

3. In the Full Name text box, type Jeff 
Thompson

4. In the Job title text box, type Marketing 
Rep

5. In the Company text box, type ACME 
Wholesale

6. In the Address text box, type 222 
Whooping Crane Hwy 
New Orleans, LA 70110

7. Make sure the This is the mailing address 
check box is selected

8. In the Phone: Business text box, type 504-
555-1612

9. In the E-mail text box, type jthompso@
acmewhol.com

10. On the toolbar, click the Save and Close 
button

The contact list reappears.

11. At the right of the screen, click the t 
alphanumeric button

The Jeff Thompson address card appears 
in the contact list.

12. Using the information shown in Table 3‑3 
as a guide, enter the first contact into 
your contact list

13. With your mail partner, select one of the 
remaining contacts for you to enter into 
your contact list and the other for your 
partner to enter, and then add the entry
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Full 
Name

Job Title Company Business 
Address

City County Post code Business 
Phone 
number

Liz Wright Marketing 
Rep

Kirk & 
Associates

Flat 2,24 
Balls Pond 
Road

London London N1 5TH 020 7423 
9636

Lucy 
Walsh

Consultant Kirk & 
Associates

33 
Brentwood 
Park Close,

Clapham

London London 21044-
0928

020 8742 
3695

Judy 
Kenning

Friend JK Computer 
Services

14 Royal 
Crescent

Swindon Wilts. SN3 5RT 01273 
569369

Table 3‑8: Contact List Information

Selecting and Editing an Address Card

Your contacts might change jobs, get new phone numbers, or give you additional information that you want to store in 
your contact list. You can edit information in your contact list directly on the address card or in the Contact window.
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Method

To select an address card:

1.	 Click the desired card.

To edit an address card:

1.	 Select the address card.
2.	 On the address card, type the changes.

or

3.	 Double-click the address card.
4.	 In the Contact window, type the changes.
5.	 On the toolbar, click the Save and Close button.

Exercise

In the following exercise, you will edit address cards in your contact list.

1. Make sure the Jeff Thompson address 
card is selected

The address card is selected.

2. Click between the H and the w in Hwy in 
the business address

The insertion point appears between the H 
and the w in Hwy.

3. Press Backspace and then type Pk The business address is now 222 Whooping 
Crane Pkwy.

4. Select the Beth Wright address card, and 
then double-click it

The Beth Wright Contact window appears.

5. In the large text box at the bottom of the 
window, type Beth markets herbs and 
spices. 

6. On the toolbar, click the Save and Close 
button

The Contact window closes and the 
changes are saved.

Transmitting and Adding Contacts with E-mail

If colleagues have someone listed in their contact lists who you would like to include in your list, too, your colleagues can 
e-mail the address card directly to you, just as you can e-mail similar cards to your colleagues. Then you can open the 
e-mail message and transfer the address card directly to your Contacts folder. Neither of you has to retype the information.

Download free eBooks at bookboon.com



Outlook 2007: Part I

70 

Organising Contacts

Method

To transmit contacts via e-mail:

1.	 Select the contact.
2.	 From the Contacts tab on the ribbon, click the send button .
3.	 From the drop down menu click ‘send as business card’
4.	 In the New Message window, address and send the message.

To add contacts from e-mail:

1.	 Open the message with the address card.
2.	 Click the address card icon attachment.
3.	 On the contact screen click Save and Close.
4.	 Open the Contacts folder to check the contact has been added successfully.

Exercise

In the following exercise, you will transmit and add contacts to your contact list with e-mail.

1. Make sure your contact list is open

2. Select the contact you created (and your 
mail partner did not create)

3. From the Contacts menu, choose Forward The New Message window appears with 
the address card as an icon in the message 
area.

4. Address the new message to your partner, 
and then send it

5. Check for new mail, and then open your 
partner’s message

6. On your partner’s message, click the 
address card icon

The address card is selected.

7. In the Message window, from the Edit 
menu, choose Copy

The address card is copied to the Clipboard.

8. Resize and reposition the Message 
window so you can see the Outlook bar

9. Open the Contacts folder

10. In the Contacts folder, from the Edit 
menu, choose Paste

The address card is added to your contact 
list.

11. On the taskbar, click the Message button 
to restore the Message window

12. Close the Message window
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Managing Contacts

Besides organizing your contact list alphabetically by contact name, Outlook lets you view it by company name, location, 
and category. For example, if you cannot remember the name of a contact but do remember that person’s workplace, you 
can view your contact list by company to find the contact. You can choose which fields you display and which you hide.

Showing and Hiding Fields

In the Contacts folder, you can view your contacts by address cards, phone list, category, company, or location. In addition, 
with the Show Fields dialog box, shown in Figure 3‑4, you can change the fields that appear on the address cards. 

Figure 3‑4: The Show Fields Dialog Box

Method

To show and hide fields:

1.	 From the View menu (in the Contacts window), choose current view and select address cards, Customize 
Current View. Then click the Fields button.

2.	 In the Show Fields dialog box, in the Available fields’ list box, select the field(s) you want to add to the view 
pane, and then choose Add. 
or

3.	 In the Show fields dialog box, in the Show these fields in this order: list box, select the field(s) you want to 
remove from the view pane, and then choose Remove.

4.	 If desired, choose New Field, and then create a new field.
5.	 If desired, in the Show these fields in this order: list, select a field and choose Move up or Move down.
6.	 Repeat step 4 as necessary to list the fields in the order you want them.
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7.	 Choose OK.

Exercise

In the following exercise, you will show and hide fields.

1. From the View menu (in the Contacts 
window), choose current view and select 
address cards, Customize Current View. 
Then click the Fields button.

The Show Fields dialog box appears.

2. In the Available fields list box, select 
Business Home Page

3. Choose Add Business Home Page appears at the bottom in 
the Show these fields in this order: list box

4. In the Show these fields in this order: list 
box, select Business Fax

5. Choose Move Up repeatedly until 
Business Fax is below Company Main 
Phone in the list

6. Choose OK The Show Fields dialog box closes.

7. Choose OK The address cards show the Business Fax 
number on each card for which such a number 
is available.
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Changing the Current View

Besides viewing address cards with one mailing address and a business and home phone number, you can change the 
Current View to display detailed address cards or a phone list that displays a contact with phone numbers but not addresses. 
You can group your contact list by company to find contacts whose name you forget.

When you change the Current View, you are applying a built-in filter. Table 3‑4 summarises the Contacts Current View 
filters.

Name Function

Business Cards Shows simple business card view

Address Cards Shows simple address cards for all contacts in the folder.

Detailed Address Cards Shows detailed address cards for all contacts in the folder.

Phone List Lists all contacts. You can sort the contacts by first or last 
name, company, and so forth.

By Category Groups contacts by category.

By Company Groups contacts by company.

By Location Lists all contacts. You can sort the contacts by state and 
country as well as by first or last name, company, and so forth.

Table 3‑9: The Contacts Current View Filters

Method

To change the Current View:

Menu method

1.	 From the View menu, choose Arrange By then select Current View.
2.	 From the Current View submenu, choose the desired view.

Toolbar method

1.	 Click the Current View drop-down list arrow.
2.	 From the drop-down list, select the view.
3.	 If necessary, in the Save View Settings message box, select the Update the view “…” with the current View 

settings option button.
4.	 Choose OK.

Exercise

In the following exercise, you will change the Current View of your contact list.
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1. Click the Current View drop-down list 
arrow 

The drop-down list appears.

2. Select Detailed Address Cards The Save View Settings message box might 
appear.

3. If necessary, select the Update the view 
“Address Cards” with the current view 
settings option button

4. Choose OK The address cards show more details.

5. Change the Current View to By Company The contacts are grouped by company.

6. If necessary, expand the list to show 
employees of Kirk & Associates

Two names appear.

Assignment

1.	 Add one of the following contacts to your contact list and arrange with your e-mail partner for your partner 
to add the other contact:
Dr. Kevin Tucker, Harley Street Clinic, 11 Harley Street, London, W1A 3RD , 020 7414 8888, 020 7414 5398

Charles Simon, Presto Pasta, 42 James Street, London, SW1 5SA, 020 7423 9671, 020 7423 9612.

2.	 Send the contact you added in step 1 above to your e-mail partner.
3.	 Add the contact your e-mail partner sent you to your contact list.
4.	 Edit the business address of the Geoff Herbert contact to read Redland Drive.
5.	 Remove the field Business Home Page from the fields you display on your address cards. In the Show Fields 

dialog box, in the Show these fields in this order: list box, move Business Fax down three places.
6.	 Change your contact list Current View to Address Cards.
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